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À propos de ce guide

Ce document est destiné aux administrateurs réseau, consultants et administrateurs PeopleSoft qui 
utilisent PeopleSoft 7.5 ou 8.1.

Le pilote DirXML® pour PeopleSoft, ci-après appelé « pilote », est conçu pour partager des 
données entre Novell® eDirectoryTM et PeopleSoft. Cette solution configurable donne aux 
entreprises les moyens d’accroître leur productivité et de rationaliser leurs processus d’entreprise 
en intégrant PeopleSoft et eDirectory.

Ce pilote se connecte à PeopleSoft via Message Agent, une interface PeopleTools. Il est possible 
de le configurer pour qu’il fonctionne avec n’importe quel module PeopleSoft.

Documentation supplémentaire

Pour obtenir une documentation sur l’utilisation de NsureTM Identity Manager et des autres pilotes, 
accédez au site Web de la documentation relative à Identity Manager 
(http://www.novell.com/documentation/french/dirxml20/index.html).

Mises à jour de la documentation

Vous trouverez la version la plus récente de ce document sur le site Web de la documentation 
relative à Identity Manager (http://www.novell.com/documentation/french/dirxml20/index.html)

Conventions utilisées dans la documentation

Le terme pilote se rapporte à tous les composants du pilote PeopleSoft et non pas à un composant 
donné. Dans ce document, toutes les références à NPS représentent Novell/PeopleSoft et non pas 
Novell Portal Services.

Dans cette documentation, le symbole « supérieur à » (>) est utilisé pour séparer deux opérations 
dans une étape de procédure ainsi que deux éléments dans un chemin de références croisées.

Le symbole de marque (®,TM, etc.) indique une marque de Novell. L’astérisque (*) indique une 
marque commerciale de fabricant tiers.
À propos de ce guide 7
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1 Présentation du pilote DirXML pour PeopleSoft

Une application PeopleSoft se compose de deux éléments principaux :

PeopleTools, qui est une infrastructure

Un ou plusieurs modules

Notamment Gestion des Ressources Humaines, Finances, Enseignement supérieur et CRM 
(Customer Resource Management - Gestion de la relation client).

Le pilote DirXML® pour PeopleSoft interagit avec PeopleSoft au niveau de PeopleTools. 
L’utilisation de définitions d’objet au sein des modules PeopleSoft et d’une collection d’objets 
préconfigurés vous permet d’activer PeopleSoft de manière à exécuter les opérations suivantes :

Intercepter des événements dans n’importe quel module PeopleSoft.

Fournir les événements interceptés à Novell® eDirectoryTM.

Collecter et traiter les données fournies.

Fournir les données via une interface PeopleTools.

Le pilote crée un lien automatisé entre PeopleSoft et eDirectory. À mesure que des enregistrements 
sont ajoutés, modifiés ou désactivés dans PeopleSoft, les tâches réseau associées à ces événements 
peuvent être traitées automatiquement.

Par exemple, lorsque des embauches, ré-embauches, cessations d’emploi et mises à jour du 
personnel ont lieu dans le module Gestion des Ressources Humaines, les tâches qui en résultent 
sont souvent créées à l’intention du service Informatique. Ces tâches peuvent inclure la 
configuration, la modification ou la désactivation d’un compte utilisateur eDirectory ou la création 
d’un compte de messagerie ou d’un compte de domaine. Il ne s’agit là que de quelques exemples 
de processus d’entreprise que ce pilote permet d’automatiser et de gérer.

Avantages
Comme l’illustrent les exemples suivants, le pilote permet d’automatiser et de mettre à jour les 
processus d’entreprise. Vous pouvez réaliser les opérations suivantes :

Création automatique d’un compte eDirectory lorsqu’une personne est embauchée ou 
lorsqu’un étudiant entre en stage.

Suppression ou désactivation automatique des comptes eDirectory lorsqu’un employé quitte 
l’entreprise.

Synchronisation bidirectionnelle des données entre PeopleSoft et eDirectory.

Contrôle de l’exactitude et de la cohérence des ID eDirectory.

Définition de règles de création de mots de passe (date de naissance, numéro de sécurité 
sociale ou combinaison du prénom et du nom, par exemple).
Présentation du pilote DirXML pour PeopleSoft 9
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Via eDirectory, intégration facile entre PeopleSoft et diverses applications (eDirectory, Lotus 
Notes*, Netscape*, Exchange, Active Directory*, par exemple).

Création d’autres objets eDirectory associés à un objet PeopleSoft (codes de compte ou 
enregistrements de service, par exemple).

Synchronisation d’attributs entre PeopleSoft et eDirectory.

Synchronisation des données de eDirectory vers PeopleSoft.

Le pilote comprend les éléments suivants :

Le programme Serveur d’événements

Le module d’interface pilote

Le programme PeopleSoft Service Agent (PSA)

Un fichier de configuration de pilote

Vous pouvez configurer le programme PSA et les objets du pilote pour améliorer les processus de 
votre entreprise. Avant d’installer et de configurer le pilote, vous devez évaluer et définir ces 
processus. Au cours de l’installation, vous procédez à la configuration des règles applicables au 
pilote afin d’automatiser ces processus chaque fois que cela est possible.

Fonctionnalités du pilote
Le pilote offre les fonctions suivantes :

Prise en charge de plusieurs infrastructures PeopleTools

Un programme Serveur d’événements distinct est disponible pour chaque version de 
PeopleTools. Ce programme se connecte au module d’interface pilote dans un socket 
Windows*.

Le traitement distant entre le module d’interface et le serveur d’événements est également 
possible. Ce qui signifie que le serveur d’événements peut être exécuté sur une machine 
distincte de celle du module d’interface pilote.

Traitement amélioré des erreurs

Le serveur d’événements peut être exécuté à partir d’une fenêtre DOS sur un ordinateur 
équipé de Windows NT*. L’écran affiche des messages de débogage au moment où un 
événement est traité. Ces messages renseignent sur l’état de la transaction affichée sur le 
serveur d’événements, ce qui vous permet de déterminer avec précision la transaction qui est 
en cours de traitement.

Fonction DSTRACE étendue.

Les messages DSTRACE contiennent une description détaillée de l’événement et du 
traitement de ce dernier.

Prise en charge de la fonction d’interrogation par Identity Manager.

Vous pouvez appliquer une règle de concordance à la fois pour le canal Éditeur et pour le canal 
Abonné. S’il n’existe aucune association entre l’objet Utilisateur eDirectory et l’employé 
PeopleSoft, le moteur DirXML exécute une règle de concordance et demande qu’une requête 
fusionne les attributs des deux objets.

Vous pouvez aussi interroger PeopleSoft sur les valeurs d’attribut nécessaires pour manipuler 
ou traiter des données dans une règle, sans avoir à copier les données dans eDirectory.
10   Guide d’implémentation du pilote DirXML pour PeopleSoft
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Paramètres de ligne de commande pour le serveur d’événements

Les paramètres de ligne de commande définissent comment exécuter le serveur d’événements 
et se connecter au module d’interface pilote, et déterminent si le serveur d’événements doit 
être installé en tant que service. Ces paramètres désignent également le chemin de 
l’environnement du client PeopleSoft. Pour plus d’informations, reportez-vous à 
« Installation du programme PeopleSoft Service Agent (PSA) », page 21.

Fonction de démarrage automatique

Vous pouvez configurer le pilote pour qu’il démarre automatiquement. Il suffit pour cela 
d’installer le serveur d’événements en tant que service Windows et de configurer l’indicateur 
de démarrage automatique sur le pilote. Pour plus d’informations, reportez-vous à 
« Installation et configuration manuelles du serveur d’événements », page 33.

Prise en charge de l’interrogation de schéma.

Le pilote peut interroger les schémas eDirectory et PeopleSoft sur les attributs qui peuvent 
être utilisés dans la règle de concordance ou interroger PeopleSoft sur les objets définis en tant 
qu’objets de règle dans l’objet Pilote.

Nouvelles fonctionnalités de Identity Manager 2
Pour plus d’informations sur les nouvelles fonctionnalités de Identity Manager, reportez-vous à 
« What’s New in Identity Manager 2? » (Nouveautés de Identity Manager 2) dans le Nsure Identity 
Manager 2 Administration Guide (Guide d’administration Nsure Identity Manager 2) 
(http://www.novell.com/documentation/french/dirxml20/admin/data/alxnk27.html).

Composants du pilote
Le pilote utilise les composants suivants :

PeopleSoft Service Agent (PSA)

Module d’interface (shim) pilote

Fichier d’importation XML

Serveur d’événements

PeopleSoft Message Agent (fourni via PeopleSoft)

Composant Pour PeopleSoft 7.5 Pour PeopleSoft 8.1

PSA dirxml_driver 3_6 psa.exe dirxml_driver 3_6 psa.exe

Module 
d’interface (shim) 
pilote

npsshim.dll npsshim.dll

Fichier 
d’importation 
XML

peoplesoft36.xml peoplesoft36.xml

Serveur 
d’événements

nps75eventserver.exe nps81eventserver.exe
Présentation du pilote DirXML pour PeopleSoft 11
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Configuration de pilote
Le pilote est chargé de notifier au moteur DirXML les événements de modification d’objet qu’il 
reçoit de PeopleSoft. Le pilote se compose d’un programme serveur d’événements et du fichier 
NPSSHIM.DLL.

Le pilote contient un canal Éditeur et un canal Abonné. Le canal Abonné reçoit les événements 
eDirectory au format XML envoyés par le moteur DirXML. Le pilote convertit ensuite ces 
documents en un flux de données adéquat, les transmet au serveur d’événements et met à jour 
PeopleSoft via l’interface Message Agent.

Le canal Éditeur reçoit les événements PeopleSoft au format XML depuis le serveur d’événements 
et les envoie au moteur DirXML pour que celui-ci les publie à son tour vers eDirectory via le canal 
Éditeur. Le moteur traite le document en appliquant de façon séquentielle toutes les règles 
configurées en fonction du flux de processus standard.

Chaque règle exécute une transformation sur le document XML. Le moteur traite le document 
d’événements en fonction des règles et du filtre trouvés dans l’objet Éditeur du pilote.

Module d’interface (shim) pilote
Le module d’interface pilote gère la communication entre le serveur d’événements et le moteur 
DirXML. Pour cette version du pilote, le module d’interface s’appelle NPSSHIM.DLL.

Serveur d’événements
Le serveur d’événements est un processus exécutable autonome. Il établit et gère la connectivité 
entre le module d’interface pilote et PeopleSoft Message Agent.

Le serveur d’événements communique avec le pilote via une interface de socket et avec Message 
Agent via les API propriétaires de PeopleSoft Message Agent.

C’est un composant bidirectionnel sur les canaux Éditeur et Abonné. Le canal Éditeur interroge 
Message Agent sur les transactions. Lorsque des transactions sont disponibles, le serveur 
d’événements lit les données d’enregistrement via Message Agent et transforme le format 
propriétaire des enregistrements PeopleSoft en une représentation au format XML. Les 
enregistrements XML sont envoyés au pilote pour être soumis à eDirectory.

De la même manière, le canal Abonné reçoit du pilote les événements eDirectory au format XML 
et les transforme au format propriétaire PeopleSoft. Les données d’événement sont ensuite 
envoyées à Message Agent pour être publiées via le canal Éditeur dans la base de données 
PeopleSoft.

PeopleSoft Service Agent
L’agent PSA (PeopleSoft Service Agent) est un logiciel que vous recevez en tant que projet 
PeopleSoft. Un agent PSA est une collection d’objets. Cette collection personnalise le module 
PeopleSoft auquel sont appliqués les objets.

Vous pouvez installer les composants de l’agent PSA puis les configurer pour n’importe quelle 
application PeopleSoft.
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L’agent PSA a une triple fonction :

Il intercepte les événements au moment où ils se produisent dans PeopleSoft.

Il place une transaction dans la liste de travail pour les événements interceptés.

Il fournit la transaction (accompagnée de données pertinentes et à jour) au pilote via 
Message Agent.

L’agent PSA comprend un échantillon de tous les objets nécessaires à PeopleSoft pour que ses 
modules PeopleSoft puissent avoir une connectivité à double sens avec le serveur d’événements.

Publication des données dans eDirectory
La publication d’événements via le canal Éditeur vers eDirectory commence avec les mises à jour 
dans PeopleSoft. À mesure que ces mises à jour ont lieu, des transactions sont placées dans une 
file d’attente de liste de travail. Ces événements sont ensuite mis à la disposition de eDirectory via 
le serveur d’événements.

Lorsque le serveur d’événements reçoit des transactions de PeopleSoft, il transforme les données 
pour obtenir un document XML qu’il transmet au module d’interface pilote. Ce dernier transmet 
le document au moteur DirXML, qui traite la transaction dans eDirectory en fonction des règles 
définies dans le pilote.

L’état de la transaction qui figure dans la liste de travail est également mis : la valeur worked 
(traité) ou error (erreur) lui est affectée. Lors de la mise à jour de l’état dans PeopleSoft, d’autres 
données PeopleCode peuvent être traitées pour déclencher l’envoi de notifications par message 
électronique aux utilisateurs ayant un rôle de flux PeopleSoft défini. Le message électronique 
contient des informations sur les transactions réussies mais aussi sur celles qui reçoivent des 
erreurs.

Description des événements
Les mises à jour ou opérations qui se produisent dans PeopleSoft entraînent l’exécution de 
déclencheurs de flux. Ces déclencheurs placent des transactions dans une file d’attente de liste de 
travail PeopleSoft. Des champs clés sont assignés à chaque transaction afin que le pilote identifie 
la transaction de manière unique.

L’un de ces champs clés est Nom de l’événement. Les noms d’événement sont assignés en fonction 
d’une opération de PeopleSoft. Le pilote contrôle la file d’attente et repère les transactions qui 
satisfont aux critères de traitement.

Il s’agit notamment des critères suivants :

Les transactions doivent avoir l’état 0.

L’opération, la date et l’heure doivent être inférieures ou égales à la date et à l’heure en cours.

Après avoir reçu l’événement, le serveur d’événements le convertit en document XML et l’envoie 
au module d’interface pilote. Ce dernier transmet le document XML au moteur DirXML. Le 
moteur applique ensuite les règles correspondant à ce type d’événement (en fonction du champ 
Nom de l’événement). Le pilote transforme le document XML en commandes eDirectory, puis il 
envoie les événements à eDirectory.
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La solution fournie prend en charge les événements de flux suivants. Par défaut, un événement 
dans PeopleSoft est égal à un événement ou document de fonction XML.

Pour déclencher l’événement correspondant au type de document XML qui doit être généré, vous 
devez configurer PeopleSoft de manière appropriée. Sans une configuration adéquate et l’examen 
de vos processus d’entreprise, une cessation d’emploi (opération) peut déclencher un événement 
de mise à jour au lieu d’un événement de suppression. Le document XML résultant sera un 
document de modification au lieu d’un document de suppression.

La configuration du pilote livrée identifie deux champs (ID de messagerie électronique et 
Description) sur le canal Abonné. Ces champs synchronisent les données entre eDirectory et 
PeopleSoft. D’autres champs PeopleSoft peuvent être publiés de eDirectory vers PeopleSoft via le 
canal Abonné en fonction des besoins de votre entreprise. Pour des informations sur le canal 
Abonné, reportez-vous à « Publication des données depuis eDirectory via le canal Abonné », 
page 16.

ADD

L’événement d’ajout est généralement déclenché par l’ajout d’un nouvel enregistrement. Pour le 
module Gestion des Ressources Humaines, cela correspond à l’embauche d’un employé. La 
création d’un nouvel enregistrement Embauche dans PeopleSoft entraîne les étapes suivantes :

1. Une définition de flux est déclenchée.
2. Une transaction d’ajout est écrite dans la liste de travail.
3. Le pilote lit la liste de travail pour obtenir une transaction, qui est accompagnée des données 

spécifiées par l’utilisateur.
4. Le pilote transforme le flux de données en un document XML.
5. Le pilote transmet le document au moteur DirXML.
6. Le moteur applique les règles qui ont été configurées.
7. Le moteur crée un objet eDirectory.

La règle SSCreate est configurée en tant qu’exemple de règle de création. Elle permet de créer 
l’objet Utilisateur. Vous pouvez aussi y définir les règles eDirectory pour le nom commun ou le 
mot de passe de login initial, ainsi que d’autres règles de création.

En fonction des besoins de votre entreprise, vous pouvez appliquer d’autres configurations à 
l’agent PSA pour fournir des éléments de données supplémentaires. Vous pouvez aussi configurer 
les règles pour qu’elles répondent aux objectifs de l’entreprise.

Événement PeopleSoft Opération PeopleSoft type Événement de fonction 
XML

ADD Nouvel employé, nouvel étudiant, nouveau 
code de compte, nouvel enregistrement.

Ajouter

UPD Toute modification apportée aux données. Par 
exemple, un champ sur un volet est modifié.

Modifier

DIS Cessation d’emploi. Un enregistrement 
devient inactif ou désactivé.

Supprimer
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Au cours du traitement d’un événement d’ajout, le système crée une association entre 
l’enregistrement PeopleSoft de l’employé et l’objet eDirectory. Pendant la création de l’objet, le 
système crée une association entre l’objet eDirectory et la clé unique de PeopleSoft. Pour le 
module Gestion des Ressources Humaines, le champ EmplID est utilisé comme champ clé et 
enregistré dans l’attribut d’association sur l’objet Utilisateur.

Lorsqu’un objet est créé, divers attributs ou éléments de données définis dans PeopleSoft peuvent 
être transmis par l’interface et utilisés pour placer l’objet. La règle de placement sur l’objet Pilote 
utilisera ces valeurs.

UPD

Les événements UPD (mise à jour) sont généralement déclenchés lorsque des données d’un champ 
PeopleSoft spécifié sont modifiées. Un flux est déclenché par l’utilisation de PeopleCode et un 
événement de mise à jour est écrit dans la liste de travail. Le pilote, appliquant le même processus 
que celui de la transaction ADD, récupère la transaction et applique les règles correspondantes. 
Dans la solution fournie, la règle eventXform permet d’appliquer ces événements. Les règles 
peuvent varier en fonction des besoins de l’entreprise.

Analysez les processus de votre entreprise pour déterminer les champs PeopleSoft qui doivent être 
synchronisés et utilisés pour les règles dans eDirectory.

Par exemple, l’emplacement, le service ou l’entreprise d’un utilisateur peuvent déterminer 
l’emplacement de l’objet Utilisateur de cette personne dans eDirectory. Si un de ces champs est 
mis à jour dans PeopleSoft, l’objet Utilisateur eDirectory doit être déplacé vers le conteneur 
adéquat en fonction de ces nouvelles informations.

Les champs PeopleSoft peuvent aussi être stockés dans eDirectory en tant qu’attributs. Numéros 
de téléphone, services, noms préférés, titres de poste et emplacements comptent parmi les champs 
courants qui peuvent être partagés par les deux systèmes. Analysez les processus de votre 
entreprise pour définir les assignations de données nécessaires entre les systèmes.

DIS

L’événement DIS est généralement déclenché par la désactivation d’enregistrements. De 
nombreuses opérations exécutées dans PeopleSoft représentent un processus de désactivation. 
Dans le module Gestion des Ressources Humaines, cet événement se produit lorsqu’un employé 
quitte l’entreprise. Lorsqu’un enregistrement de cessation d’emploi est créé dans PeopleSoft, le 
système déclenche un flux et écrit une entrée dans la liste de travail.

Important : le déclenchement d’une transaction de suppression génère un document XML de suppression.

L’entreprise peut choisir de supprimer, de désactiver ou de désactiver et déplacer le compte 
eDirectory. Comme pour le processus de modification/mise à jour, la règle eventXform est fournie 
afin de montrer comment un document XML de suppression est transformé en document de 
modification.

Remarque : par défaut, lorsque le canal Éditeur traite un événement, l’ID et le DN (nom distinctif) eDirectory 
sont mis à jour dans PeopleSoft. Vous pouvez désactiver ce processus en mettant à jour les propriétés XML 
du pilote.
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Publication des données depuis eDirectory via le canal Abonné
PeopleSoft est le processus expert pour les événements d’ajout et de suppression/désactivation. 
Par conséquent, le pilote par défaut permet les mises à jour dans PeopleSoft uniquement sur le 
canal Abonné.

Dans la mesure où PeopleSoft est une base de données relationnelle (et non hiérarchique), les 
processus de déplacement et de réassignation de nom ne sont généralement pas applicables. Si ces 
processus se produisent dans eDirectory pour un objet pour lequel le pilote est défini sur le canal 
Abonné, le pilote les convertit en événement de modification. Cette opération lui permet de mettre 
à jour l’ID eDirectory et le nom distinctif eDirectory dans PeopleSoft, à condition que le processus 
de mise à jour ne soit pas désactivé.

Le pilote oublie, via le canal Abonné, les événements de modification qui se produisent dans 
eDirectory. PeopleSoft est conçu pour être le propriétaire expert des données contenues dans 
la solution fournie. Par conséquent, si un objet Utilisateur est créé dans eDirectory, aucun 
enregistrement d’employé n’est créé dans PeopleSoft à l’aide de la configuration par défaut.

Les éléments de données PeopleSoft qui sont publiés de eDirectory vers PeopleSoft via le canal 
Abonné doivent :

se trouver sur le filtre du canal Abonné ;

exister dans la définition de message DIRXML_SCHEMA01_UPDATE et la définition de 
message DIRXML_SCHEMA01 dans PeopleSoft (ou définitions équivalentes).

Lorsque le pilote est averti d’une modification à un attribut sélectionné dans son filtre Abonné, 
il envoie l’événement au serveur d’événements. Ce dernier formate l’événement puis met à jour 
PeopleSoft en communiquant par l’intermédiaire de PeopleSoft Message Agent. Les données 
provenant de eDirectory peuvent être placées sur un volet ou une page dans PeopleSoft.

Puisque leur mise à jour et leur gestion se font hors de PeopleSoft, il convient de leur assigner la 
propriété Display Only (Affichage seul) dans PeopleSoft. Il n’est pas conseillé de permettre à un 
même élément de donnée d’être modifié à l’intérieur et à l’extérieur de PeopleSoft. Il faudrait pour 
cela que l’élément soit défini sur les deux canaux (Éditeur et Abonné) du pilote.

Vous pouvez mettre des données à jour dans PeopleSoft en fonction d’un enregistrement 
PeopleSoft existant. Pour cela, vous devez écrire les données PeopleCode adéquates pour que les 
éléments de données mis à jour dans la définition d’enregistrement DIRXML_STAGE01 soient 
aussi copiés vers l’enregistrement souhaité dans l’environnement PeopleSoft.
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2 Installation du pilote en cours 

Cette section contient les informations suivantes :

« Configuration requise pour le pilote », page 17.

« Importation de la configuration du pilote », page 17.

« Activation du pilote », page 20.

Configuration requise pour le pilote
Novell® NsureTM Identity Manager 2

Windows NT 4.0 avec Service Pack 5 ou supérieur ou Windows 2000

Version appropriée de PeopleTools et Tuxedo* Application Server

Instructions d’installation
Le pilote est installé avec le programme d’installation de Novell Nsure Identity Manager 2. 
Pour les instructions d’installation, reportez-vous au Novell Nsure Identity Manager 2 
Administration Guide (Guide d’administration Novell Nsure Identity Manager 2) 
(http://www.novell.com/documentation/french/dirxml20/index.html).

Importation de la configuration du pilote
L’assistant de création de pilote vous permet d’importer le fichier de configuration de base du 
pilote. Ce fichier crée et configure les objets et les règles nécessaires au bon fonctionnement 
du pilote.

Les instructions suivantes expliquent comment créer le pilote et importer sa configuration.

1 Dans Novell iManager, cliquez sur Utilitaires DirXML > Créer un pilote.

2 Sélectionnez un ensemble de pilotes

Si vous placez ce pilote dans un nouvel ensemble de pilotes, vous devez spécifier un nom 
d’ensemble de pilotes, ainsi qu’un contexte et un serveur associé.

Plate-forme PeopleSoft Version de PeopleTools

PeopleSoft 7.5 PeopleTools 7.57 ou version ultérieure

PeopleSoft 8.1 PeopleTools 8.17 ou version ultérieure
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3 Sélectionnez Importer une configuration de pilote à partir du serveur, puis PeopleSoft36.xml.

Les fichiers de configuration du pilote sont installés sur le serveur Web lorsque vous installez 
Identity Manager. Pendant l’importation, vous serez invité à donner les paramètres du pilote 
et d’autres informations.

4 Indiquez les paramètres du pilote, puis cliquez OK pour l’importer.

Nom du paramètre Description

Nom du pilote Nom réel à utiliser pour le pilote.

Conteneur des 
utilisateurs actifs

Nom de l’objet Unité organisationnelle dans lequel sont placés les utilisateurs actifs.

Conteneur des 
utilisateurs inactifs

Nom de l’objet Unité organisationnelle dans lequel sont placés les utilisateurs inactifs.

Groupe des 
employés actifs

Nom de l’objet Groupe dans lequel sont ajoutés les « employés » actifs.

Groupe des 
directeurs actifs

Nom de l’objet Groupe dans lequel sont ajoutés les utilisateurs « directeurs » actifs.

Nom d’hôte et port 
du serveur 
d’événements

Nom d’hôte ou adresse IP et numéro de port de l’ordinateur sur lequel se trouve le serveur 
d’événements PeopleSoft.

Chaîne de 
connexion 
PeopleSoft

Nom d’hôte ou adresse IP et numéro port permettant de se connecter au serveur d’applications 
PeopleSoft approprié. C’est ce qu’on appelle généralement la chaîne de connexion du serveur 
d’applications PeopleSoft. Le port par défaut est 9000.

ID utilisateur 
PeopleSoft

ID de l’utilisateur PeopleSoft que le pilote utilise à des fins d’authentification pour PeopleSoft.

Mot de passe 
PeopleSoft

Mot de passe de l’utilisateur PeopleSoft, que le pilote utilise à des fins d’authentification pour 
PeopleSoft.

Configurer le flux de 
données

Vous pouvez configurer le flux de données selon l’une des options suivantes :

Bi-directionnel : PeopleSoft et eDirectoryTM sont des sources expertes des données synchronisées 
entre eux.

PS vers eDirectory : PeopleSoft est la source experte.

eDirectory vers PS : eDirectory est la source experte.

Installer le pilote 
comme 
Distant/Local

Pour configurer le pilote afin de l’utiliser avec le service du chargeur distant, sélectionnez l’option 
Remote ; sélectionnez Local pour configurer l’utilisation en local du pilote. Si vous sélectionnez Local, 
vous pouvez omettre les paramètres qui restent.

Nom d’hôte et port 
distants

Indique le nom de l’hôte ou l’adresse IP et le numéro de port de l’emplacement sur lequel le service de 
chargeur distant a été installé et s’exécute pour ce pilote. Le port par défaut est 8090.

Mot de passe du 
pilote

Ce mot de passe est utilisé par le chargeur distant pour s’authentifier auprès du serveur DirXML®. Il doit 
être identique à celui indiqué comme mot de passe de l’objet Pilote sur le chargeur distant du DirXML.

Mot de passe à 
distance

Le mot de passe du chargeur distant est utilisé pour contrôler l’accès à l’instance du chargeur distant. 
Il doit être identique à celui indiqué comme mot de passe du chargeur distant sur le chargeur distant 
du DirXML.
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Les paramètres de pilote supplémentaires sont fixés à des valeurs par défaut pendant le 
processus d’importation, mais ils peuvent être modifiés dans iManager (en cliquant sur 
l’onglet Configuration du pilote de l’objet Pilote).

Nom du paramètre Description

Numéro de port du serveur 
d’événements

Numéro du port IP utilisé par le composant Serveur d’événements du pilote pour 
écouter la connexion du module d’interface pilote.

Champ d’ID d’enregistrement de 
données

Nom du champ dans le CI du schéma de données qui identifie de manière unique un 
objet PeopleSoft. La valeur par défaut est utilisée en tant qu’identificateur d’association 
d’objets DirXML. Le nom par défaut du champ est DIRXML_ASSOC_ID.

Activité d’abonnement aux données 
de schéma

Nom de l’objet Activity (Activité) de PeopleSoft qui définit les données pouvant être 
synchronisées entre eDirectory et l’application PeopleSoft. L’activité d’abonnement par 
défaut est DIRXML_SCHEMA01_UPDATE.

Vérifiez que la définition de message qui figure dans cette activité correspond au nom 
de l’activité.

Activité de requête des données de 
schéma

Nom de l’objet Activity (Activité) de PeopleSoft qui définit les données que le pilote lit 
dans l’application PeopleSoft. Ces données sont généralement le sous-ensemble des 
éléments de données contenus dans l’activité d’édition des données de schéma. 
L’activité de requête par défaut est DIRXML_SCHEMA01_QUERY.

Vérifiez que la définition de message qui figure dans cette activité correspond au nom 
de l’activité.

Intervalle d’interrogation de la file 
d’attente (en secondes)

Nombre de secondes pendant lequel le pilote attend entre deux tentatives de 
traitement d’enregistrements de transaction. Cet intervalle s’applique uniquement 
lorsqu’aucune transaction n’est disponible pour être traitée.

L’intervalle d’interrogation par défaut est de 5 secondes.

Capacité d’extraction de la file 
d’attente

Ce paramètre spécifie le nombre de transactions récupérées par le pilote dans la file 
d’attente de la liste de travail chaque fois qu’il accède à l’activité d’accès aux 
transactions.

La valeur par défaut est 5.

Activité d’accès aux transactions Nom de l’objet Activity (Activité) de PeopleSoft qui définit l’ensemble des champs 
requis pour l’interface de transaction DirXML. Pour que le pilote puisse fonctionner, 
l’ensemble des champs de l’activité de transaction spécifiée doit contenir les mêmes 
champs et clés que ceux qui figurent dans l’activité de transaction par défaut.

L’activité de transaction par défaut est DIRXML_TRANS0.

Vérifiez que la définition de message qui figure dans cette activité correspond au nom 
de l’activité.

Activité d’édition des données de 
schéma

Nom de l’objet Activity (Activité) de PeopleSoft qui définit l’ensemble de données qui 
doit être synchronisé entre PeopleSoft et eDirectory.

L’activité d’édition par défaut est DIRXML_SCHEMA01.

Vérifiez que la définition de message qui figure dans cette activité correspond au nom 
de l’activité.

Remarque : les autres champs clés de contrôle des transactions (les noms de champ 
sont entièrement en lettres majuscules), qui sont contenus dans la définition de 
message, ne sont utilisés qu’à des fins de traitement et ne sont pas synchronisés.
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Lorsque l’importation est terminée, vous pouvez définir des équivalences de sécurité et 
exclure de la réplication les rôles administratifs.

L’objet Pilote doit posséder les droits eDirectory suffisants sur tout objet qu’il lit ou écrit. 
L’attribution de ces droits s’effectue en accordant l’équivalence de sécurité à l’objet Pilote. 
Le pilote doit avoir un accès en lecture/écriture sur les utilisateurs, les bureaux de poste, les 
ressources et les listes de distribution, ainsi que des droits Créer, Lire et Écrire sur le conteneur 
du bureau de poste. Il doit généralement disposer d’un niveau de sécurité de niveau Admin.

5 Passez en revue les objets Pilote dans la page Résumé et cliquez sur Terminer.

Activation du pilote
L’activation doit être réalisée dans les 90 jours suivant l’installation, sinon le pilote ne s’exécutera 
pas.

Pour plus d’informations sur l’activation, reportez-vous à « Activating Novell Identity Manager 
Products » (Activation des produits de Novell Identity Manager) dans le Novell Nsure Identity 
Manager 2 Administration Guide (Guide d’administration de Novell Nsure Identity Manager 2).

Mise à niveau du pilote
Pour des informations détaillées sur la manière de mettre à niveau le pilote 3.51 ou 3.6 
vers la version 3.6a, reportez-vous au TID N° 2963871 disponible sur le site Web 
http://support.novell.com (http://support.novell.com).
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3 Configuration de votre système PeopleSoft

Utilisez les informations présentées à la section suivante pour configurer votre système PeopleSoft 
afin de partager et synchroniser les données avec Novell® eDirectoryTM.

« Installation du programme PeopleSoft Service Agent (PSA) », page 21

« Exécution du programme de test de Message Agent », page 29

« Installation du serveur d’événements », page 33

Installation du programme PeopleSoft Service Agent (PSA)
La procédure d’installation du programme PSA varie selon les versions de PeopleSoft.

« Installation de PSA pour PeopleSoft 7.5 », page 22

« Installation de PSA pour PeopleSoft 8.1 », page 26

Remarque : dans ces sections, toutes les références à des chemins spécifiques représentent les valeurs par 
défaut indiquées durant les procédures d’installation. Appliquez les changements nécessaires le cas échéant.

Installation de PSA pour PeopleSoft 7.5
Si vous utilisez PeopleSoft 7.5, exécutez les tâches suivantes pour installer le programme PSA :

« Extraction des fichiers PSA », page 21

« Installation du programme PeopleSoft Service Agent (PSA) », page 22

« Copie du projet d’intégration Novell dans une base de données DMO cible », page 23

« Établissement de la sécurité pour les objets PSA dans PeopleSoft 7.5 », page 25

Extraction des fichiers PSA

Le projet PSA est fourni sous la forme d’un projet à extraction automatique. Pour extraire le projet, 
procédez comme suit :

1 Exécutez dirxml_driver_36.exe depuis l’emplacement que vous avez spécifié pour 
l’installation des composants de PeopleSoft. L’emplacement par défaut est Novell\nds\ps.

2 Cliquez sur Next (Suivant), sélectionnez le répertoire cible, puis cliquez sur Next (Suivant) 
pour extraire les fichiers PSA.

3 Cliquez sur Finish (Terminer) pour quitter le processus d’extraction.

Le projet PSA est maintenant prêt à être installé dans votre environnement PeopleSoft.
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Installation du programme PeopleSoft Service Agent (PSA)

Pour pouvoir installer et configurer les objets PeopleSoft, vous devez disposer d’un ID utilisateur 
et d’un mot de passe PeopleSoft avec des droits d’administrateur ou de développeur. Vous pouvez 
créer un ID utilisateur et un mot de passe uniques pour implémenter ces objets.

Pour appliquer l’ensemble d’objets PSA fourni, suivez les procédures PeopleSoft standard de mise 
à niveau. Pour des informations sur les procédures de mise à niveau PeopleSoft, reportez-vous à 
la documentation PeopleSoft.

Installation de PSA pour PeopleSoft 7.5

Data Mover est un outil d’application qui permet d’importer des objets PeopleSoft externes dans 
une base de données PeopleSoft 7.5. En appliquant la procédure PeopleSoft standard de mise à 
niveau, vous pouvez utiliser Data Mover pour déplacer Identity Manager pour les projets 
PeopleSoft dans l’environnement PeopleSoft de votre entreprise.

Un script Data Mover (DMS) est fourni avec le pilote. Ce script importe les objets nouveaux et 
modifiés dans les tables du dictionnaire des données. N’exécutez ce script que sur une base de 
données AUD (Application Update Database - base de données de mise à jour d’application) 
rafraîchie. Le rafraîchissement de la base de données permet de résoudre tout conflit entre les 
objets fournis et ceux qui existent déjà dans la base de données AUD.

Avertissement : si le script DMS est exécuté sur une base de données autre que la base de données AUD, 
il se peut qu’il échoue ou qu’il écrase les données existantes. L’exécution du script directement sur la base de 
données de développement PeopleSoft endommage cette dernière.

Vérifiez dans le répertoire C:\PSA que les fichiers DMS ont bien été copiés pendant l’installation 
des composants. Il s’agit du répertoire par défaut utilisé par le programme d’installation. Si vous 
avez modifié ce paramètre pendant l’installation, vérifiez le répertoire que vous avez indiqué. Les 
étapes ci-après constituent la procédure par défaut pour importer les objets PeopleSoft externes :

1 Dans le menu Démarrer, cliquez sur Programmes > PeopleSoft > Data Mover.

2 Loguez-vous à la base de données AUD.

3 Cliquez sur File > Open (Fichier > Ouvrir).

4 Recherchez le fichier de votre installation > sélectionnez le script DMS avec le numéro de 
version adéquat. (Par exemple, DIRXML_DRIVER_PSA_36IMP.DMS.)

Il doit être identique à celui de la base de données PeopleSoft.

5 Dans la boîte de dialogue de syntaxe Data Mover, vérifiez que les fichiers d’entrée et les 
fichiers journaux pointent sur le répertoire qui contient les fichiers de données (.dat) sur 
l’unité locale.

L’exemple ci-après illustre la syntaxe fournie :

SET OUTPUT c:\PSA\AU_CHECK.DAT;

SET INPUT c:\PSA\PSA-PS75\DIRXML_DRIVER_PSA_36IMP.DAT;

SET LOG c:\PSA\DIRXML_DRIVER_PSA_36IMP.LOG;

SET NO TRACE;

SET IGNORE_DUPS;

EXPORT AU_CHECK;

IMPORT *;
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6 Sélectionnez File > Run Script (Fichier > Exécuter le script).

Dans le rapport qui s’affiche dans le volet d’état inférieur, vérifiez que l’importation a réussi. 
Si l’importation échoue, vérifiez que les chemins d’entrée et de sortie pointent sur les 
répertoires adéquats.

7 Fermez Data Mover.

Copie du projet d’intégration Novell dans une base de données DMO cible

Votre base de données DMO cible contient le catalogue système, les structures du dictionnaire des 
données et un exemple de données d’application. Lors du transfert d’une base de données AUD 
vers une base de données DMO cible, les objets du dictionnaire des données de la base de données 
AUD sont copiés dans le dictionnaire de données de la base de données cible.

Une fois l’opération de copie terminée, vous devez créer la base de données. Cette opération 
permet de créer les tables physiques ou vues dans la base de données sous-jacente pour que les 
objets deviennent accessibles. Pour exécuter cette procédure, vous devez vous loguer en tant 
qu’utilisateur doté de droits d’administration.

Nous vous recommandons de procéder comme suit :

Utilisez une copie propre d’une base de données DMO cible pour cette procédure.

Si vous appliquez une copie à une base de données qui contient des données de production, 
faites-en une copie et effectuez une comparaison avant d’appliquer la copie de la base de 
données cible.

Exécutez une installation et testez-la avec une base de données DMO cible.

Effectuez cette opération avant de modifier la configuration et d’appliquer la base de données 
à un environnement de développement ou de production.

Pour copier le projet dans une base de données DMO cible, procédez comme suit :

1 Dans le menu Démarrer, cliquez sur Programmes > PeopleSoft > PeopleTools.

2  Loguez-vous à la base de données AUD.

3 Cliquez sur Go > PeopleTools > Application Designer > File > Open (Aller > Application 
Designer > Fichier > Ouvrir).

4 Cliquez sur Object Type (Type d’objet), puis sur Project (Projet).

5 Cliquez sur Selection Criteria, Name (Critères de sélection, Nom), tapez 
DIRXML_DRIVER_PSA_36, puis cliquez sur Select (Sélectionner).

6 Cliquez sur le projet, puis sur Select (Sélectionner).

7 Cliquez sur Tools > Upgrade > Copy (Outils > Mettre à niveau > Copier).

8 Tapez le nom de la base de données DMO cible (dans laquelle le projet sera copié), l’ID 
d’opérateur et le mot de passe, puis cliquez sur OK.

Veillez à sélectionner le projet et tous les objets qu’il contient.

9 Cochez la case Export Project (Exporter le projet) pour exporter les objets vers la base de 
données cible, puis cliquez sur Copy (Copier).

Tous les objets de la base de données AUD sont copiés dans la base de données DMO cible.

10 Fermez la fenêtre Application Designer.
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Création de définitions d’enregistrement de projet

Une fois que vous avez importé le projet dans la base de données PeopleSoft, créez des définitions 
d’enregistrement de projet, puis des vues de projet.

1 Dans le menu Démarrer, cliquez sur Programmes > PeopleSoft > PeopleTools.

2 Loguez-vous à la base de données DMO cible en utilisant un nom d’utilisateur administrateur 
doté de droits d’administration et de développement.

3 Dans Application Designer, cliquez sur File (Fichier), puis sur Open (Ouvrir).

4 Sélectionnez le projet DIRXML_DRIVER_PSA_36, puis cliquez sur Open (Ouvrir).

5 Cliquez sur Build > Project (Créer > Projet).

6 Dans Build Options (Options de création), cliquez sur Create Tables (Créer des tables) et sur 
Execute SQL Now (Exécuter SQL maintenant).

7 Cliquez sur Build (Créer) pour créer des exemples de tables de projet. Une fois les tables de 
projet créées, cliquez sur Close (Fermer) pour fermer la fenêtre Build Progress (Progression 
de la création).

Vous devez créer les tables de projet avant de créer les vues. Ces dernières sont créées en 
fonction des informations des champs de table.

8 Dans Application Designer, sélectionnez Build > Project (Créer > Projet).

9 Dans Build Options (Options de création), cliquez sur Create Views (Créer des vues) et sur 
Execute SQL Now (Exécuter SQL maintenant).

10 Cliquez sur Build (Créer) pour créer des exemples de vues de projet. Une fois les vues créées, 
cliquez sur Close (Fermer) pour fermer la fenêtre Build Progress (Progression de la création).

À présent, vous devez établir les rôles et lancer le flux. Reportez-vous à « Établissement des rôles 
et lancement du flux », page 24.

Établissement des rôles et lancement du flux

Un rôle est une classe d’utilisateurs qui exécutent le même le type de travail. Ce sont les 
procédures d’entreprise qui déterminent généralement l’activité exécutée par un rôle. 
L’administrateur eDirectory a été désigné comme le rôle qui exécute les événements d’ajout, de 
mise à jour et de suppression/désactivation. Cela signifie que le flux doit être activé et qu’un 
utilisateur à rôle doit être assigné au rôle d’administrateur eDirectory. Pour activer un flux, 
procédez comme suit :

1 Cliquez sur Go > PeopleTools > Workflow Administrator (Aller > PeopleTools > Workflow 
Administrator).

2 Cliquez sur Use > Workflow System Defaults > Defaults (Utiliser > Paramètres par défaut du 
système de flux > Paramètres par défaut).

3 Cochez la case Worklist Active (Liste de travail active).

4 Si vous utilisez une messagerie et d’autres formes de communication électroniques, cochez 
les cases correspondantes.

5 Vérifiez qu’un utilisateur du rôle par défaut (généralement Admin WF) est également assigné 
et cliquez sur Save (Enregistrer). Si un flux n’est pas en cours d’utilisation par d’autres 
processus, assignez alors cet utilisateur au rôle d’administrateur eDirectory.

Vous devez maintenant assigner des droits de sécurité aux nouveaux objets. Reportez-vous à 
« Établissement de la sécurité pour les objets PSA dans PeopleSoft 7.5 », page 25.
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Établissement de la sécurité pour les objets PSA dans PeopleSoft 7.5

Vous pouvez assigner des droits de sécurité à tous les nouveaux volets et toutes les nouvelles pages 
qui ont été ajoutés à un projet. Utilisez un compte de type administrateur pour établir la sécurité.

Application de la sécurité pour les nouveaux objets PSA

1 Cliquez sur Go > PeopleTools > Security Administrator (Aller > PeopleTools > 
Administrateur de sécurité).

2 Cliquez sur File > Open (Fichier > Ouvrir). Sélectionnez ALLPANLS dans Operator Class 
(Classe d’opérateur), puis cliquez sur OK.

3 Cliquez sur l’icône Menu Items (Éléments de menu) dans le volet gauche.

4 Cliquez sur Insert > Menu Name (Insérer > Nom de menu).

5 Double-cliquez sur DirXML_Administrator_36, cliquez sur Select All (Sélectionner tout), 
puis sur OK.

6 Cliquez sur Select All (Sélectionner tout), puis sur OK.

7 Enregistrez.

8 Vous pouvez maintenant quitter l’interface Security Administrator (Administrateur 
de sécurité).

Vérification de l’accès aux objets PSA

Une fois la sécurité appliquée aux nouveaux objets PSA, utilisez l’exemple d’application pour 
vérifier que vous pouvez accéder aux données, les modifier et les enregistrer.

Vous pouvez effectuer des tests pour vous assurer que des transactions sont créées en entrant une 
nouvelle personne à l’aide de l’exemple d’application. Cet exemple utilise des services ; vous 
devez donc créer un exemple de service, puis ajouter une personne (en l’assignant à ce service) 
pour vérifier que l’application fonctionne.

Pour tester des exemples d’application PeopleSoft, procédez comme suit :

1 Connectez-vous en tant qu’administrateur à la base de données PeopleSoft en mode à deux 
niveaux.

2 Dans Application Designer, cliquez sur Go > DirXML Administrator 36 EP (Aller > DirXML 
Administrator 36 EP).

3 Sélectionnez Use > DirXML Sample Department (Utiliser > Exemple de service DirXML).

4 Cliquez sur une ligne de champ Department (Service) vide pour ajouter un exemple de service 
et une description.

5 Cliquez sur Save (Enregistrer) pour ajouter le service.

6 Sélectionnez Use > DirXML Sample People > Add (Utiliser > Exemple de personne 
DirXML > Ajouter).

7 Indiquez un numéro d’ID pour la nouvelle personne, puis cliquez sur OK.

8 Entrez les données dans les divers champs associés à cet ID, puis cliquez sur Save 
(Enregistrer).

Les champs obligatoires sont : First Name (Prénom), Last Name (Nom), Birth Date 
(Date de naissance), Status (État), Title (Titre) et Department ID (ID de service).
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9 Pour vérifier qu’une transaction d’ajout a été créée, accédez au menu Worklist Maintenance 
(Gestion de la liste de travail) de eDirectory. Cliquez sur Use > eDirectory Worklist 
Maintenance > eDirectory Worklist (Utiliser > Gestion de la liste de travail eDirectory > Liste 
de travail eDirectory). Vous pouvez maintenant rechercher l’ID que vous venez de créer.

10 Cliquez sur le bouton Search (Rechercher).

11 Double-cliquez sur l’événement que vous avez créé. Vérifiez dans les volets que les données 
que vous avez entrées y figurent.

12 Fermez le client PeopleSoft.

Maintenant que vous avez exécuté les tâches requises pour l’installation et la configuration du 
programme PSA, passez à l’étape « Exécution du programme de test de Message Agent », 
page 29.

Installation de PSA pour PeopleSoft 8.1
Exécutez les tâches suivantes pour installer l’exemple de projet à des fins de test et de 
configuration :

1. « Extraction des fichiers PSA », page 26

2. « Importation du projet PSA dans la base de données PeopleSoft », page 26

3. « Création de définitions d’enregistrement de projet », page 27

4. « Test des exemples d’application PeopleSoft », page 27

Remarque : dans ces sections, toutes les références à des chemins spécifiques représentent les valeurs par 
défaut indiquées durant les procédures d’installation. Appliquez les changements nécessaires le cas échéant.

Extraction des fichiers PSA

Le projet PSA est fourni sous la forme d’un projet à extraction automatique. Pour extraire le projet, 
procédez comme suit :

1 Exécutez DIRXML_DRIVER_36.EXE depuis l’emplacement que vous avez spécifié pour 
l’installation des composants de PeopleSoft. L’emplacement par défaut est Novell\NDS\PS.

2 Cliquez sur Next (Suivant), sélectionnez le répertoire cible, puis cliquez sur Next (Suivant) 
pour extraire les fichiers PSA.

3 Cliquez sur Finish (Terminer) pour quitter le processus d’extraction.

Le projet PSA est maintenant prêt à être installé dans votre environnement PeopleSoft.

Importation du projet PSA dans la base de données PeopleSoft

Depuis la version 8 de PeopleSoft, les projets sont fournis dans une structure de répertoires cache 
similaire à la structure du cache existant dans PeopleSoft. Dans les versions précédentes de 
PeopleSoft, vous deviez utiliser le script de Data Mover et effectuer une comparaison, mais ce 
processus n’est plus nécessaire.

Pour importer le projet PSA dans la base de données PeopleSoft, procédez comme suit :

1 Connectez-vous en tant qu’administrateur à la base de données PeopleSoft en mode à deux 
niveaux.

2 Dans Application Designer, sélectionnez File > Copy Project From File (Fichier > Copier le 
projet à partir du fichier).
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3 Cliquez sur Browse (Parcourir) et sélectionnez le répertoire du projet PSA : C:\PSA\PSA-
PSA8\.

4 Cliquez sur Copy (Copier).

5 Avec tous les types d’objet sélectionnés, cliquez sur Copy (Copier) pour copier tous les 
composants du projet dans la base de données PeopleSoft.

Création de définitions d’enregistrement de projet

Une fois que vous avez importé le projet dans la base de données PeopleSoft, créez des définitions 
d’enregistrement de projet, puis des vues de projet.

1 Loguez-vous à PeopleSoft en utilisant un nom d’utilisateur administrateur doté de droits 
d’administration et de développement.

2 Dans Application Designer, sélectionnez Build > Project (Créer > Projet).

3 Dans Build Options (Options de création), cliquez sur Create Tables (Créer des tables) et sur 
Execute SQL Now (Exécuter SQL maintenant).

4 Cliquez sur Build (Créer) pour créer des exemples de tables de projet. Une fois les tables de 
projet créées, cliquez sur Close (Fermer) pour fermer la fenêtre Build Progress (Progression 
de la création).

Vous devez créer les tables de projet avant de créer les vues. Ces dernières sont créées en 
fonction des informations des champs de table.

5 Dans Application Designer, sélectionnez Build > Project (Créer > Projet).

6 Dans Build Options (Options de création), cliquez sur Create Views (Créer des vues) et sur 
Execute SQL Now (Exécuter SQL maintenant).

7 Cliquez sur Build (Créer) pour créer des exemples de vues de projet. Une fois les vues créées, 
cliquez sur Close (Fermer) pour fermer la fenêtre Build Progress (Progression de la création).

Test des exemples d’application PeopleSoft

Vous pouvez effectuer des tests pour vous assurer que des transactions sont créées en entrant une 
nouvelle personne à l’aide de l’exemple d’application. Cet exemple utilise des services ; vous 
devez donc créer un exemple de service, puis ajouter une personne (en l’assignant à ce service) 
pour vérifier que l’application fonctionne.

Pour tester des exemples d’application PeopleSoft, procédez comme suit :

1 Connectez-vous en tant qu’administrateur à la base de données PeopleSoft en mode à deux 
niveaux.

2 Dans Application Designer, sélectionnez Go > DirXML Administrator36 (Aller > 
Administrateur36 DirXML).

3 Dans le menu DirXML Administrator (Administrateur DirXML), sélectionnez Use > 
DirXML Sample Department (Utiliser > Exemple de service DirXML).

4 Cliquez sur une ligne de champ Department (Service) vide pour ajouter un exemple de service 
et une description.

5 Cliquez sur Save (Enregistrer) pour ajouter le service.

6 Dans le menu DirXML Administrator 36 (Administrateur 36 DirXML), cliquez sur Use > 
DirXML Sample People > Add (Utiliser > Exemple de personne DirXML > Ajouter).

7 Indiquez un numéro d’ID, puis cliquez sur OK.
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8 Entrez les données dans les divers champs associés à cet ID, puis cliquez sur Save 
(Enregistrer).

Les champs obligatoires sont : First Name (Prénom), Last Name (Nom), Birth Date (Date de 
naissance), Status (État), Title (Titre) et Department ID (ID de service).

9 Pour vérifier qu’une transaction d’ajout a été créée, cliquez sur Use > eDirectory Worklist 
Maintenance > eDirectory Worklist (Utiliser > Gestion de la liste de travail eDirectory > Liste 
de travail eDirectory).

10 Cliquez sur le bouton Search (Rechercher) pour rechercher l’utilisateur que vous avez ajouté.

11 Double-cliquez sur l’événement pour afficher les détails le concernant.
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12 Une fois que vous avez vérifié que les événements ont été correctement configurés, vérifiez 
que vous pouvez modifier les données et les enregistrer. Cliquez sur Use > eDirectory 
Subscriber (Utiliser > eDirectory Subscriber).

13 Cliquez sur le bouton Search (Rechercher) pour localiser l’exemple de personne que vous 
avez créé.

14 Entrez un exemple de valeur (ou modifiez une valeur existante) dans le champ du numéro de 
téléphone, puis cliquez sur Save (Enregistrer).

15 Cliquez sur Use > eDirectory Query > DirXMLQuery01 (Utiliser > eDirectory Query 
>DirXMLQuery01).

16 Cliquez sur le bouton Search (Rechercher), puis double-cliquez sur votre exemple de 
personne.

17 Vérifiez que le numéro de téléphone que vous avez ajouté ou modifié a changé.

18 Vous pouvez maintenant quitter le client PeopleSoft.

Maintenant que vous avez réalisé les étapes nécessaires pour configurer le programme PSA, 
passez à « Exécution du programme de test de Message Agent », page 29.

Exécution du programme de test de Message Agent
Vous pouvez tester les agents de messages de PeopleSoft suivants :

DIRXML_TRANS01

DIRXML_SCHEMA01

DIRXML_SCHEMA01_UPDATE

DIRXML_SCHEMA01_QUERY

Pour obtenir des informations de dépannage détaillées sur le système de test de Message Agent, 
reportez-vous au Chapitre 4, « Dépannage du pilote », page 37.
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Test de PeopleSoft Message Agent DIRXML_TRANS01
Dirxml_trans01.ist vérifie que Message Agent reçoit des événements de la liste de travail.

Remarque : les fichiers de script dont le nom est suivi du chiffre 8 sont destinés à PeopleSoft 8.1. Les autres 
scripts IST sont destinés à PeopleSoft 7.5.

1 Cherchez le répertoire C:\PSA\PSA-P75\ ou C:\PSA\PSA-P8\.

2 Copiez le programme de test correspondant à un agent de messages dans le répertoire 
{ps_home}\bin\client\winx86.

3 Créez sur le bureau un raccourci pour le programme de test de Message Agent.

4 Affichez les propriétés du programme et vérifiez que le fichier .IST n’est pas en lecture seule.

5 Double-cliquez sur le programme de test.

6 Cliquez sur File > Open (Fichier > Ouvrir).

7 Cliquez sur le fichier dirxml_trans01.ist, puis sur Open (Ouvrir).

8 Vérifiez que la chaîne de connexion, l’ID d’opérateur et le mot de passe appropriés sont listés 
pour la connexion au serveur d’application.

9 Cliquez sur Execute! (Exécuter).

Si Message Agent fonctionne correctement, la liste des champs clés de traitement est 
renseignée.

Vous trouverez ci-dessous un exemple de script :

Connect 137.65.147.162:7000,PS,PS; StartMessage 
DIRXML_TRANS01,DIRXML_TRANS01; ProcessMessage; GetOutPutall; Disconnect;

Dans ce script, la chaîne de connexion est 137.65.147.162:7000. L’ID utilisateur et le mot de 
passe sont PS.

Vous pouvez maintenant fermer la fenêtre DIRXML_TRANS01. Ne fermez pas le programme de 
test de Message Agent car vous allez l’utiliser aux étapes suivantes.

Test de PeopleSoft Message Agent DIRXML_SCHEMA01
Dirxml_schema.ist vérifie que tous les champs contenus dans la définition du processus 
d’entreprise DIRXML_SCHEMA01 sont transmis à Message Agent.

1 Double-cliquez sur le programme de test de messages.

2 Cliquez sur File > Open (Fichier > Ouvrir).

3 Cliquez sur le fichier dirxml_schema01.ist, puis sur Open (Ouvrir).

4 Vérifiez que la chaîne de connexion, l’ID d’opérateur et le mot de passe appropriés sont listés.

5 Modifiez les champs INSTANCEID, INSTSTATUS, ACTIVITY NAME et EVENTNAME.

Version de PeopleSoft Programme de test

PeopleSoft 7.5 psmtst32v75.exe

PeopleSoft 8.1 psmtst32v80.exe
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Pour obtenir ces informations, recherchez la personne et affichez le volet DIRXML_SCHEMA01 
dans le volet eDirectory Work List Maintenance (Gestion de la liste de travail eDirectory), 
comme illustré ci-après :

Ces champs doivent correspondre à l’événement pour lequel vous essayez de recevoir les 
données de sortie. À partir des résultats du test précédent, copiez et collez les valeurs 
appropriées. Ces résultats ont été générés lors du test de dirxml_trans01.ist.

6 Cliquez sur Save (Enregistrer).

7 Cliquez sur Execute! (Exécuter).

Si Message Agent fonctionne correctement, tous les champs qui sont renseignés dans 
PeopleSoft le sont également dans la sortie.

Vous trouverez ci-dessous un exemple de script :

Connect 137.65.147.182:7000,PS,PS; StartMessage 
DIRXML_SCHEMA01,DIRXML_SCHEMA01; Setfield 
BUSPROCNAME=DIRXML_INTEGRATION; Setfield ACTIVITYNAME=DIRXML_EVENT1; 
Setfield EVENTNAME=ADD; Setfield WORKLISTNAME=DIRXML_ADD; Setfield 
INSTANCEID=5; Setfield INSTSTATUS=0; Setfield COMMENTSHORT=Selected; 
ProcessMessage; GetOutPutall; Disconnect;

8 Fermez les fichiers journaux.

Test de PeopleSoft Message Agent DIRXML_SCHEMA01_UPDATE
Dirxml_schema01_update.ist teste les mises à jour de l’enregistrement PeopleSoft 
DIRXML_SCHEMA01_UPDATE. Ce processus teste les événements qui proviennent de 
eDirectory plutôt que de PeopleSoft.

1 Double-cliquez sur le programme de test de messages.

2 Cliquez sur File > Open (Fichier > Ouvrir).

3 Cliquez sur le fichier dirxml_schema01_update.ist, puis sur Open (Ouvrir).

4 Vérifiez que la chaîne de connexion, l’ID d’opérateur et le mot de passe appropriés sont listés.
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5 Modifiez ASSOC ID, NDS ID, NDS CONTEXT et les champs Description.

Ils doivent correspondre à l’employé que vous essayez de mettre à jour.

6 Cliquez sur Save (Enregistrer).

7 Cliquez sur Execute! (Exécuter).

Si Message Agent fonctionne correctement, les champs eDirectory d’ID, de nom distinctif, 
d’adresse électronique et de description correspondant à l’employé sélectionné sont utilisés 
pour renseigner la page eDirectory Subscriber (Canal Abonné eDirectory). Cette page 
correspond au volet NDS Data Update (NDS de mise à jour des données) pour PeopleSoft 7.5.

Vous trouverez ci-dessous un exemple de script :

Connect 137.65.139.178:7000,PS,PS; StartMessage 
DIRXML_SCHEMA01_UPDATE,DIRXML_SCHEMA01_UPDATE; SetField Assoc ID=8964; 
SetField NDS ID=GHORNBE; SetField NDS CONTEXT=NCS.PRV.NOVELL; SetField 
Description=Updated; SetField email=unknown; ProcessMessage; 
GetOutPutall; Disconnect;

8 Fermez le fichier journal.

Test de PeopleSoft Message Agent DIRXML_SCHEMA01_QUERY
DirXML_schema01_query.ist teste la fonction d’interrogation pour le pilote à partir de 
PeopleSoft. Ce processus teste la capacité à récupérer des données de PeopleSoft en fonction du 
champ ASSOC ID.

Les champs de sortie définis sur l’objet Interrogation doivent être équivalents à ceux définis sur 
l’objet DIRXML_SCHEMA01.

La principale différence entre ces deux objets réside dans les champs d’entrée clés. Seul l’ID de 
cet objet est le champ clé (par exemple Assoc ID).

1 Double-cliquez sur le programme de test de messages.

2 Cliquez sur File > Open (Fichier > Ouvrir).

3 Cliquez sur le fichier dixml_schema01_query.ist, puis sur Open (Ouvrir).

4 Vérifiez que la chaîne de connexion, l’ID d’opérateur et le mot de passe appropriés sont listés.

5 Modifiez la valeur de Assoc ID.

Il doit correspondre à l’employé auquel vous tentez d’accéder.

6 Cliquez sur Execute! (Exécuter).

Si Message Agent fonctionne correctement, tous les champs qui sont renseignés dans 
PeopleSoft le sont également dans la sortie.

Vous trouverez ci-dessous un exemple de script :

Connect 137.65.139.178:7000,PS,PS; StartMessage 
DIRXML_SCHEMA01_QUERY,DIRXML_SCHEMA01_QUERY; SetField Assoc ID=8964; 
ProcessMessage; GetOutPutall; Disconnect

7 Fermez le fichier journal.

Maintenant que vous avez testé vos agents de messages PeopleSoft, installez le serveur 
d’événements. Reportez-vous à « Installation du serveur d’événements », page 33.
32   Guide d’implémentation du pilote DirXML pour PeopleSoft



    Novell Confidential                                                                                            Manual (FRA)  28 October 2003
Installation du serveur d’événements

Installation et configuration manuelles du serveur d’événements
Généralement, le serveur d’événements est installé au moment de l’exécution du programme 
d’installation. Si l’un des cas suivants s’est produit, installez ou configurez manuellement le 
raccourci sur le bureau pour le serveur d’événements :

Vous n’avez pas installé le serveur d’événements lors de l’installation des autres composants.

Plusieurs chemins de répertoire n’étaient pas disponibles pendant l’installation.

Installation du serveur d’événements

Les étapes suivantes supposent que eDirectory a été installé sur l’unité C du serveur dans le 
répertoire \novell\remoteloader\.

1 Copiez les programmes ci-après dans le répertoire c:\novell\nds.

Nps75eventserver.exe pour PeopleSoft 7.5

Nps81eventserver.exe pour PeopleSoft 8.1

2 Créez un raccourci sur le bureau pour l’application du serveur d’événements.

Important : si vous exécutez plusieurs pilotes PeopleSoft, créez un raccourci pour chaque serveur 
d’événements.

3 Éditez la ligne de commande dans le champ Target (Cible).

Le graphique ci-après illustre ce champ :

Cliquez avec le bouton droit de la souris sur le raccourci > cliquez sur Propriétés > Raccourci.

Entrez les paramètres du raccourci. Dans le tableau suivant, {PS_Home} est la racine de la 
structure de répertoires PeopleSoft.

Plate-forme 
PeopleSoft

Paramètres

PeopleSoft 7.5 C:\Novell\NDS\NPS75EventServer.exe -c -s:16386 
-p:PS_Home\bin\client\winx86

PeopleSoft 8.1 C:\Novell\NDS\NPS81EventServer.exe -c -s:16394 
-p:PS_Home\bin\client\winx86
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Le paramètre -c configure le serveur d’événements pour qu’il fonctionne en tant 
qu’application de la console. Lorsque vous utilisez ce paramètre, configurez les propriétés 
suivantes pour la fenêtre DOS :

Barre de défilement

Une présentation de couleur différente

Le serveur d’événements communique avec le pilote via une interface Windows Sockets ou 
un port d’écoute. Le tableau ci-après liste le numéro de socket fourni pour chaque serveur 
d’événements. Si ces chiffres entrent en conflit avec des sockets déjà utilisés dans votre 
entreprise, utilisez un autre ensemble de ports.

Puisque chaque serveur d’événements exige quatre sockets ou ports consécutifs, les numéros 
de socket qui identifient les différents serveurs d’événements doivent respecter un intervalle 
d’au moins quatre chiffres.

Le serveur d’événements doit établir les communications avec PeopleSoft Message Agent. 
Pour cela, il se connecte aux fichiers DLL de PeopleSoft Message Agent.

Ces fichiers DLL se trouvent généralement dans le répertoire 
PS_HOME\BIN\CLIENT\WINX86.

Pour le raccourci NPS75EventServer, voici un exemple de chemin d’accès aux fichiers DLL 
de PeopleSoft Message Agent : -p:d:\psoft\hr757\bin\client\winX86. Dans cet 
exemple, PS_HOME est égal à d:\psoft\hr757.

4 Saisissez ce qui suit dans le champ Start In (Démarrer dans) :

c:\Novell\NDS
Il s’agit du répertoire dans lequel eDirectory est installé. La figure ci-après illustre ce champ :

5 Sélectionnez Apply (Appliquer) puis cliquez sur OK.

6 Ouvrez l’application via le raccourci.

Vous pouvez personnaliser la barre de défilement et les couleurs dans l’onglet Property (Propriété) 
de la fenêtre.

Serveur d’événements Port

Serveur d’événements PeopleSoft 7.5 16386

Serveur d’événements PeopleSoft 8.1 16394
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Arrêt du serveur d’événements

Il peut s’avérer nécessaire d’arrêter le serveur d’événements pour rafraîchir la connectivité de 
PeopleSoft, recycler le serveur ou effectuer un débogage. Lorsque vous l’arrêtez, le serveur 
d’événements envoie une commande d’arrêt au module d’interface pilote, qui s’arrête avant que 
le serveur d’événements ne se ferme.

Pour arrêter le serveur d’événements depuis la fenêtre de la console, procédez comme suit :

1 Sélectionnez la fenêtre du serveur d’événements.

2 Entrez Q.

Important : pour arrêter le serveur d’événements, cliquez sur l’icône Exit (Quitter) dans la fenêtre. Mais ne 
faites cette action que si le module d’interface pilote n’est pas en cours d’exécution. Avant de cliquer sur 
l’icône, arrêtez le module d’interface pilote à partir du menu Propriétés de l’ensemble de pilotes DirXML.

Installation du serveur d’événements en tant que service

Vous pouvez installer le serveur d’événements en tant que service Windows NT ou Windows 2000. 
Généralement, l’installation du serveur d’événements a lieu pendant l’installation du pilote.

Au cours de l’installation, deux autres raccourcis sont créés sur le bureau. Ils permettent de créer 
ou de supprimer le serveur d’événements en tant que service.

Pour installer le serveur d’événements en tant que service, procédez comme suit :

1 Vérifiez que le serveur d’événements est disponible.

Sur une machine locale, vérifiez que NPSxEvent Server.exe est enregistré en local sur la 
machine.

Si vous installez le serveur d’événements sur un serveur distant, sur lequel eDirectory 
n’est pas installé, copiez les fichiers dirxmllib.dll et expat.dll du répertoire novell\nds 
dans le répertoire à partir duquel le serveur d’événements sera exécuté.

Remarque : le client PeopleSoft doit toujours être installé sur le serveur sur lequel le serveur 
d’événements sera exécuté.

L’adresse IP du serveur distant est utilisée au moment de configurer le serveur 
d’événements dans la boîte de dialogue Paramètres du pilote.

2 À l’invite de commande, accédez au répertoire dans lequel le fichier exécutable est stocké et 
entrez la commande suivante :

NPS75EventServer.exe -i -s:16386 -p: PS_HOME\bin\client\winx86
Selon votre environnement et la configuration de votre serveur, il est possible que le numéro 
de socket et le chemin du fichier Psmsg.dll de PeopleSoft soient différents.

3 Dans le menu Démarrer, cliquez sur Paramètres > Panneau de configuration > Services > 
Serveur d’événements DirXML pour PS 7.5 (ou la version adéquate).

4 Cliquez sur Démarrage > sélectionnez le bouton d’option Automatique pour démarrer 
automatiquement le serveur d’événements au login, puis cliquez sur Démarrer.

Pour arrêter le service, procédez comme suit :

1 Dans le menu Démarrer, cliquez sur Paramètres > Panneau de configuration > Services.

2 Sélectionnez le service, puis cliquez sur Arrêter.
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Désinstallation manuelle du serveur d’événements en tant que service

Vous pouvez désinstaller ou supprimer le serveur d’événements en tant que service. Pour cela, 
suivez les mêmes étapes que pour l’installation du serveur d’événements, mais à l’étape 2, 
remplacez le paramètre -i par le paramètre -u.

Entrez, par exemple, NPS75EventServer.exe -u -s:16386 -p: PS_HOME\bin\client\winx86

Remarque : il n’y a aucune fenêtre pour la console lorsque le serveur d’événements s’exécute en tant que 
service. Toutes les informations de débogage sont disponibles uniquement dans le journal DSTRACE.
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4 Dépannage du pilote

Cette section décrit les problèmes potentiels et les codes d’erreur que vous pouvez rencontrer lors 
de la configuration ou de l’utilisation du pilote.

Résolution des erreurs

Le serveur d’événements ne se charge pas.
Vérifiez la variable d’environnement path afin de vous assurer que le client PeopleSoft et le 
répertoire de Identity Manager figurent dans son chemin.

Le pilote ne démarre pas.
Vérifiez que le serveur d’événements est en cours d’exécution.

Vérifiez que le fichier npsshim.dll est accessible.

Vérifiez que les paramètres de connexion sont corrects.

Le pilote ne communique pas avec le serveur d’événements
Vérifiez que le serveur d’événements a été démarré en premier.

Vérifiez que plusieurs copies du serveur d’événements et du pilote ne sont pas en cours 
d’exécution.

Vérifiez que la connexion n’a pas été interrompue précédemment.

Vous devrez peut-être redémarrer Novell® eDirectoryTM puis redémarrer les composants 
du pilote.

Le serveur d’événements reçoit des erreurs de Message Agent.
Vérifiez que les API sont correctement configurées. (Utilisez le programme de test de 
Message Agent.)

Vérifiez que le serveur d’applications est en cours d’exécution.

Vérifiez la connectivité avec Message Agent.
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Vérifiez que vous disposez de la chaîne de connexion correcte pour le serveur d’applications 
PeopleSoft :

Vous pouvez utiliser NOM_D’HÔTE:PORT ou IP:PORT pour une seule instance du serveur 
d’applications

ou

Utilisez le mode de reprise après échec //NOM_D’HÔTE:PORT,//NOM_D’HÔTE:PORT où 
la première entrée est le premier serveur d’applications et la deuxième entrée est le deuxième 
serveur d’applications auquel le pilote tente de se connecter.

Vérifiez que l’orthographe des noms des API de Message Agent est correcte. Ces noms 
respectent la casse.

Vérifiez que la mise à jour de la transaction de liste de travail ne génère pas d’erreur.

Vérifiez qu’il n’y a pas d’erreurs dans le serveur d’applications.

Vérifiez qu’il n’y a pas d’erreurs dans la passerelle SMTP.

Vérifiez l’usage du mot de passe du pilote. Il peut respecter la casse selon votre plate-forme.

Les attributs ne sont pas rafraîchis sur l’objet d’assignation de données.
Vérifiez que les API de Message Agent fonctionnent correctement.

Vérifiez que les API de liste de travail et de mise à jour des données fonctionnent correctement 
(DIRXML_SCHEMA01 et DIRXML_SCHEMA01_UPDATE).

Le pilote semble ne traiter que les transactions. 
Les transactions semblent être lues dans la liste de travail, mais le pilote ne traite rien. Les 
messages se répètent. Le texte de sortie suivant peut apparaître sur la console du serveur 
d’événements :

Record Count: 5

Processing record 1 of 5.

Processing record 2 of 5.

Processing record 3 of 5.

Processing record 4 of 5.

Processing record 5 of 5.

Pourtant, aucune donnée n’est traitée. Les transactions de la liste de travail sont bien lues mais les 
données ne sont pas extraites des transactions. Vérifiez que vous pouvez lire les données dans la 
définition de message par défaut DIRXML_SCHEMA01. Vous devez également effectuer les 
opérations suivantes :

Vérifiez que vous pouvez lire une transaction particulière avec le programme de test des 
messages.

Vérifiez que vous n’obtenez qu’un seul enregistrement lorsque vous accédez à la même 
transaction en ligne.

Vérifiez que le champ ACTIONDTTM a été supprimé en tant que champ d’entrée sur l’API.
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Les données ne s’affichent pas sur le canal Éditeur de eDirectory.
Vérifiez que la règle et les filtres d’assignation sont correctement configurés.

Vérifiez que les API fonctionnent correctement et qu’elles produisent des données.

Les données ne sont pas mises à jour sur le canal Abonné de PeopleSoft.
Vérifiez que la règle et les filtres d’assignation sont correctement configurés.

Vérifiez que les API fonctionnent correctement.

Aucune transaction n’est publiée via le canal Éditeur.
Vérifiez que la case de synchronisation par défaut de eDirectory est cochée.

Vérifiez que la file d’attente inclut des transactions actives prêtes à être traitées.

Vérifiez que les paramètres du pilote pointent sur la base de données PeopleSoft correcte. 
Par exemple, les transactions ne sont pas traitées si elles se trouvent dans la base de données 
PROD et si le pilote pointe toujours sur la base de données test (celle-ci est configurée pour 
être exécutée avec le pilote mais elle ne contient pas de transactions). 

Les transactions ne sont pas placées dans la file d’attente de PeopleSoft.
Vérifiez que PeopleCode fonctionne correctement.

Vérifiez que vous n’êtes pas en mode Correction lors de l’exécution des mises à jour.

Aucune donnée n’est renvoyée lors de l’exécution du programme de test des 
messages.

Aucune donnée n’est renvoyée, notamment lorsque vous exécutez le programme de test des 
messages. Des erreurs telles que « No Text Available. » (Aucun texte disponible) peuvent 
s’afficher.

Généralement, cette erreur a deux raisons :

Les éléments d’entrée clés ne pointent pas sur l’enregistrement de recherche dans la définition 
d’assignation des champs de l’activité.

Les éléments de champ pointent sur une référence non valide.

Vérifiez que les éléments d’entrée clés sont associés à l’entrée de l’enregistrement de recherche 
dans la définition d’assignation des champs et pas directement à la table. Vérifiez également que 
les éléments de champ sont assignés à la définition d’enregistrement de champ adéquate, qui existe 
dans le tampon de l’application. Vérifiez que des éléments de données existent sur une page dans 
l’application et que les liaisons sont correctement configurées.
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Les transactions sont laissées dans l’état sélectionné et ne sont pas traitées.
Vérifiez que toutes les activités de message peuvent être traitées et que les états peuvent être 
mis à jour et prendre la valeur 2 (worked) (traitée) ou 4 (error) (erreur).

Si la messagerie électronique est configurée dans PeopleSoft et si la passerelle SMTP est hors 
service, une erreur peut se produire et provoquer l’échec de la mise à jour de la liste des 
transactions. Vérifiez que tous les traitements en ligne de l’application fonctionnent 
correctement. Les données PeopleCode jointes à la mise à jour peuvent parfois échouer, 
provoquant ainsi l’échec de la transaction. Si la connectivité du système est perdue, la base de 
données ou le serveur d’applications est mis hors service et le traitement de la transaction par 
le pilote est abandonné. Celle-ci est alors laissée à l’état « selected » (sélectionnée) avec l’état 1.

Réception d’erreurs sur le canal Éditeur lors du traitement d’une transaction.
Voici des exemples d’erreurs et des informations sur leur signification :

Operation vetoed by Create policy (L’opération s’est heurtée à un veto de la règle de création).

Des données requises sont peut-être manquantes dans la règle de création ou d’autres critères 
de la règle de création comportent une erreur.

generateKeyPair: -216 DSERR_PASSWORD_TOO_SHORT

L’attribut utilisé pour le mot de passe initial ne respecte pas la règle, mais l’objet Utilisateur 
sera néanmoins créé.

Unable to read current state of 8101 (Impossible de lire l’état actuel de 8101).

Aucune association n’existe pour cette identité.

nameToID: -601 ERR_NO_SUCH_ENTRY

Erreur possible dans la règle de placement avec désignation d’un objet Conteneur non valide.

No DN generated by Placement policy (Aucun nom distinctif généré par la règle de 
placement)

Données peut-être manquantes ou non valides provoquant la création d’aucun nom distinctif 
valide.

Les relations avec Message Agent ne fonctionnent pas.
Si les données n’apparaissent pas dans les attributs, si elles ne sont pas publiées dans PeopleSoft 
ou si des données sont manquantes, vous devriez commencer par examiner les relations avec 
l’agent de messages. Procédez comme suit :

Vérifiez que l’API reçoit les données du tampon de PeopleSoft. (Utilisez le programme de test 
de l’agent de messages et suivez les quatre étapes du processus du pilote pour tester toutes les 
API.)

Voici, pour les activités fournies avec Message Agent, le processus à suivre pour tester les 
scripts de Message Agent à l’aide du programme de test. L’objectif de ce test est de valider, 
entièrement et étape par étape, le processus qu’utilise le pilote pour s’interfacer avec 
PeopleSoft, récupérer des transactions et mettre à jour l’environnement PeopleSoft. Toutes les 
applications auxquelles sont connectées les activités de message doivent être testées en ligne 
via PeopleTools avant de tester les scripts de Message Agent :

1 Vérifiez qu’il n’existe qu’une transaction active/disponible prête à être traitée dans la liste de 
travail.
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2 Exécutez le script dirxml_trans01.ist pour récupérer la transaction dans la liste de travail.

3 Vérifiez que les éléments clés de la transaction sont renvoyés et qu’ils sont uniques.

4 Exécutez le deuxième script, DIRXML_SCHEMA01, et remplacez les valeurs de l’élément 
clé par les valeurs récupérées à l’étape 2 ci-dessus après l’exécution du script 
dirxml_trans01.ist. Modifiez l’état INSTSTATUS à 1 pour représenter la mise à jour de la 
transaction PeopleSoft à l’état sélectionné.

5 Vérifiez que tous les éléments de données apparaissent comme souhaité.

Si des éléments sont manquants, il est probable que les données récupérées sur l’une des pages 
dans l’application posent problème. Vérifiez les pages ...DATA1X, ...DATA2X et ...DATA3X 
dans l’application associée. Même si les données apparaissent sur la page, elles ne figurent 
pas toujours dans les résultats de l’exécution du script en raison d’un problème dans la 
définition d’affichage.

La non-visibilité des données peut aussi être liée au fait que le sens du processus n’est pas 
configuré sur la sortie pour l’assignation de champs dans la définition d’activité.

6 Répétez les étapes 4 et 5 en exécutant à nouveau le script pour la même transaction tout en 
passant l’état à 2 (worked) (traitée) et à 4 (error) (erreur).

Lorsqu’il traite une transaction, le pilote lui assigne toujours l’état 1 (selected) (sélectionnée). 
Une fois qu’elle est traitée, il lui attribue l’état 2 (worked) (traitée) ou 4 (error) (erreur). En 
cas d’erreur, le champ de commentaire est également mis à jour. Veillez à tester toutes les 
mises à jour possibles et à vérifier en ligne que la mise à jour a bien eu lieu et comme souhaité.

7 Exécutez le script DIRXML_SCHEMA01_UPDATE pour un objet particulier. Pour un 
employé donné, spécifiez par défaut l’EMPLID de cet employé. Les champs NDS ID et NDS 
CONTEXT sont mis à jour dans PeopleSoft sur l’enregistrement DIRXML_TRANS01 
lorsque le pilote termine le traitement d’une transaction récupérée auprès du canal Éditeur. 
Si cette opération échoue, le pilote ne peut pas terminer la mise à jour de l’état qui intervient 
aux étapes précédentes. La mise à jour de ces champs n’est effectuée qu’à des fins de 
documentation ou pour rendre ces champs disponibles ailleurs dans PeopleSoft, ou pour les 
utiliser dans un message électronique généré par un flux PeopleSoft, etc. Cette fonction peut 
être désactivée à l’aide d’un paramètre prioritaire défini dans la page des paramètres de 
propriétés dans la configuration du pilote.

Remarque : exécutez le script plusieurs fois en remplaçant le contenu des champs Description et Email 
ID et/ou de tout autre champ qui a pu être ajouté à la table DIRXML_TRANS01 et à cette définition, et 
qui sont configurés pour être mis à jour par le pilote sur le canal Abonné, c’est-à-dire de eDirectory vers 
PeopleSoft.

8 Exécutez le script DIRXML_SCHEMA01_QUERY pour confirmer que les éléments de 
données pour un objet particulier sont accessibles.

Ces éléments doivent aussi être configurés sur sortie, sauf pour la valeur d’entrée clé. Les 
éléments listés ici sur l’assignation des champs doivent correspondre à ceux qui figurent dans 
la définition DIRXML_SCHEMA01. La seule différence étant les champs d’entrée clés. Sur 
cette activité, il existe normalement un champ d’entrée clé pour l’objet auquel le système 
accède. Ce qui équivaut à EMPLID pour la configuration livrée avec la base de données HR.
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Lorsque tous les scripts du programme de test de l’agent de messages ont été entièrement testés 
avec validation de tous les processus pour lesquels le pilote est configuré, le pilote ne devrait plus 
rencontrer de difficultés pour accéder à PeopleSoft via Message Agent. Il existe d’autres 
problèmes types, notamment :

l’adresse IP et port de connectivité pour le serveur d’applications,

l’ID et le mot de passe,

l’assignation du nom correct à toutes les activités dans les paramètres du pilote.

N’oubliez pas qu’il y a trois phases de test de base :

1. Tester tous les processus manuellement en ligne à l’aide des applications PeopleSoft telles que 
configurées.

2. Tester tous les processus à l’aide des quatre scripts de test du programme de test de Message 
Agent.

3. Tester le pilote lorsqu’il se connecte aux activités via Message Agent.
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5 Mises à jour du contenu de la documentation

Cette section contient des informations concernant les modifications qui ont été faites dans ce 
Guide d’implémentation du pilote DirXML Novell pour PeopleSoft. Ces informations vous 
permettront d’être au courant des mises à jour de la documentation.

Elles sont regroupées en fonction de la date de publication des mises à jour de la documentation. 
Dans une section datée, les modifications sont données dans l’ordre alphabétique selon les noms 
des principales sections de la table des matières pour les Règles et Services de Distribution.

Cette documentation existe en deux formats sur le Web : HTML et .PDF. Les documentations au 
format .HTML et .PDF sont toutes deux mises à jour grâce aux modifications répertoriées dans 
cette section.

Si vous voulez savoir si la copie de la documentation PDF que vous utilisez est la plus récente, la 
date de publication du document PDF se trouve dans la section Mentions légales immédiatement 
après la page de titre.

Cette documentation a été mise à jour aux dates suivantes :

« 26 avril 2004 », page 43

26 avril 2004
Les références à DirXML® 2.0 ont été modifiées en Identity Manager 2. Il est toujours fait 
référence au moteur et aux pilotes comme le moteur DirXML et les pilotes DirXML.
Mises à jour du contenu de la documentation 43



    Novell Confidential                                                                                            Manual (FRA)  28 October 2003
44   Guide d’implémentation du pilote DirXML pour PeopleSoft


	À propos de ce guide
	1 Présentation du pilote DirXML pour PeopleSoft
	Avantages
	Fonctionnalités du pilote
	Nouvelles fonctionnalités de Identity Manager 2

	Composants du pilote
	Configuration de pilote
	Module d’interface (shim) pilote
	Serveur d’événements
	PeopleSoft Service Agent

	Publication des données dans eDirectory
	Description des événements

	Publication des données depuis eDirectory via le canal Abonné

	2 Installation du pilote en cours
	Configuration requise pour le pilote
	Instructions d’installation
	Importation de la configuration du pilote
	Activation du pilote
	Mise à niveau du pilote

	3 Configuration de votre système PeopleSoft
	Installation du programme PeopleSoft Service Agent (PSA)
	Installation de PSA pour PeopleSoft 7.5
	Installation de PSA pour PeopleSoft 8.1

	Exécution du programme de test de Message Agent
	Test de PeopleSoft Message Agent DIRXML_TRANS01
	Test de PeopleSoft Message Agent DIRXML_SCHEMA01
	Test de PeopleSoft Message Agent DIRXML_SCHEMA01_UPDATE
	Test de PeopleSoft Message Agent DIRXML_SCHEMA01_QUERY

	Installation du serveur d’événements
	Installation et configuration manuelles du serveur d’événements


	4 Dépannage du pilote
	Résolution des erreurs
	Le serveur d’événements ne se charge pas.
	Le pilote ne démarre pas.
	Le pilote ne communique pas avec le serveur d’événements
	Le serveur d’événements reçoit des erreurs de Message Agent.
	Les attributs ne sont pas rafraîchis sur l’objet d’assignation de données.
	Le pilote semble ne traiter que les transactions.
	Les données ne s’affichent pas sur le canal Éditeur de eDirectory.
	Les données ne sont pas mises à jour sur le canal Abonné de PeopleSoft.
	Aucune transaction n’est publiée via le canal Éditeur.
	Les transactions ne sont pas placées dans la file d’attente de PeopleSoft.
	Aucune donnée n’est renvoyée lors de l’exécution du programme de test des messages.
	Les transactions sont laissées dans l’état sélectionné et ne sont pas traitées.
	Réception d’erreurs sur le canal Éditeur lors du traitement d’une transaction.
	Les relations avec Message Agent ne fonctionnent pas.


	5 Mises à jour du contenu de la documentation
	26 avril 2004


